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 1 Modification History
Revision Date Comments

2



1.0 February 28, 2018 Initial Release

1.1 March 12, 2018 Described new layout of the header in the Message Window.
Described new global options settable via GUI.

1.2 April 9, 2018 Enhanced search scope to include from, to, subject fields, 
message text and text attachments.
Eliminated false negative searches by first decoding base64 and 
quoted-printable content blocks.
Enhanced mboxview index file to keep track of text content 
blocks to optimize message and attachments search 
performance.
Deprecated searching of RAW mail data.

1.3 April 16, 2018 Added Next/Previous search options to Find dialog.
Optimized message text search performance and significantly 
reduced number of cases of false positive search results.

1.4 May 5, 2018 Added  Picture Viewer dialog to preview attachments with the 
png, jpg, jpeg, jpe, gif, bmp, ico, tif, tiff, jfif, emf, wmf, dib 
suffixes.
The Picture Viewer is enabled by default by it can be disabled 
on the fly via fly via File->Options dialog.

1.0.2.6 October 8, 2018 Synchronized the version number of this document with the 
release number.
Added context menu to the mail archive under Mail Tree, 
summary mail in the Summary window and attachments.  
Added new options to the File and View main menus.
Context menus enable user to print single, group or all mails to 
CSV, Text or HTML files, sort mails by date, from, to, subject, 
size and conversation groups, find and highlight all occurrences 
of the searched text.
This release resolves the text encoding issues in the summary 
window, i.e. text is now shown correctly.
Added image cache to properly handle inline images within an 
email.

1.0.2.7 November 6, 
2018

Fixed picture orientation in Picture Viewer.
Added mail message retrieval state in the status bar.
Improved performance of Picture Viewer to reduce flicker.
Added zoom slider and image dragging using mouse to Picture 
Viewer.

1.0.2.8 December 14, 
2018

- Version specific changes are tracked as shown in this line so 
they can be more easily identified by the user.
- Added handling of embedded images declared incorrectly as 
non inline attachments in the mail.
- Fixed incorrect text alignment in some cases when printing 
group of mails to HTML;
- Added html2text conversion to print mails with only HTML 
block and no plain text block.
- Added progress bar when printing mail archive to Text or 
HTML or CSV files. The html2tewxt conversion is quite slow 
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and it was necessary to introduce the progress bar.
- Fixed race condition (introduced in 1.0.2.7) that could result in
message and mail summary out of sync.

1.0.3.0 February 26, 2019 See what is new and what changed section.

 2 What is new and what changed in version 1.0.3.0

 2.1 What is new
1. Added mail list editing capability to enable users to compose mail list by merging results of

multiple searches and/or by merging one or more user selected mails. See 6.16. 
2.  Added capability to archive search results to the archive file.
3.  Added capability to archive the mail list composed by a user to the archive file.
4.  Added capability to reload mail list composed by users from the archive file.
5.  Added capability to select one or more mails and print, remove and/or copy.
6.  Added option to directly print mails to user selected printer.
7.  Added Advanced Find/Search capability. See 6.13.2.
8. Added option to set Message Window position to Bottom, Right or Left.
9.  Added option to standard Find dialog to find all matching mails.
10. Added option to configure unique file name for printing a mail to a file.

 2.2 What changed
1. Updated status bar to display the number of the selected mail and the total number of mails.
2. Added “Find all occurrences” to the Find dialog.
3. Changed folder to house images embedded into mails from C:\Users\USER_NAME\

AppData\Local\Temp\mboxview to FolderHousingMailArchives/ImageCache. This is to 
make sure folder persists reliably across computer restarts.

4. Added  FolderHousingMailArchives/PrintCache to save printed mails.
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 3 Feedback
To help to improve MBox Viewer, please post reviews what works and what doesn’t, create bug 
reports and request for enhancements. Provide as many details as possible, such as country, 
screenshots, etc.

 4 Overview
MBox Viewer (or mboxview) is Windows GUI based program to view mbox files such as 
Thunderbird Archives, Google mail archives or simple Eml files. 

The mbox viewer is a simple but quite powerful email viewer that supports the following features:

1. large file support > 4Gb

2. fast parsing of mbox archives

3. quick access to all attachments

4. preview picture attachments

5. zoom in/out a picture

6. export of single mail in Eml

7. print all mails to CSV or Text or HTML files

8. print single mail to Text or HTML file or send to printer

9. group all related mails as conversations 

10. print related mails/mail group to Text or HTML file

11. open single mail or group of related mails in a browser

12. find user defined text in mail’s message and highlight all occurrences

13. search the date, subject, sender, message text and text appendix

14. sort by date, from, to, subject, size and conversation groups

15. support for mail’s header fields and body encoded with different character sets

16. support for mail list editing capability to enable users to compose mail list by merging results of
multiple searches and/or by merging one or more user selected mails. 

17. support to set Message Window position to Bottom, Right or Left.

 5 Installation
The executable and the source code can be downloaded from Sourceforge or Github.

https://sourceforge.net/projects/mbox-viewer/files/

https://github.com/eneam/mboxviewer/releases

Download the executable package, the latest mbox-viewer.exe-v1.0.3.0.zip,  to the working 
directory and unzip. This will create the mbox-viewer.exe-v1.0.3.0 directory and the stand-alone 
mboxview.exe executable and User Guide in that directory. No administrator privileges are 
required.
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 6 Running the MBox viewer
The mboxview program can be executed by double clicking the executable from the explorer 
window or from the command line by typing the command name and argument list to it. 

 6.1 Argument List Summary
The mboxview accept the following command line options.  

-FOLDER=folderPath – the full path to the folder containing one or more mbox or eml files. 
Persists in the registry across multiple runs.

-MAIL_FILE=fileName – full file path or just file name of mbox/eml file to load. If the full path is
not specified, the full path is created from the folderPath and the fileName. Doesn’t persist in the 
registry across multiple runs.

-EXPORT_EML=y|n – enables or disables automatic export of eml files generated from mbox 
archive. Improves traversing performance of mail if set to ‘n”. Persists in the registry across 
multiple runs.

-PROGRESS_BAR_DELAY=seconds – search progress bar is activated when the search duration 
lasts longer than the value set for PROGRESS_BAR_DELAY. If set to -1, the progress bar is 
disables. Default value is set to 1 seconds. Persists in the registry across multiple runs.

If desired, instead of typing directly desired command line options, a simple .cmd or .bat file can be 
created for convenience and run from the explorer.

 6.2 Setting Options from GUI
The EXPORT_EML and PROGRESS_BAR_DELAY values can be changed on the fly at any 
time from GUI.

Click on the “File” to open the drop menu and then select the “Options” option. The below dialog 
will be presented. Set the desired values followed by OK button.

Note that if exporting of EML files is disabled, you can still export the eml file for the selected mail 
by selecting “View EML” under the “View” drop menu. 

Two options, “Show Charsets” and “Set Character Sets for Header Fields”,  can help to properly
display header fields in the Message Window. See  6.15.1.1 for additional details.

The “Picture Viewer” check box enables/disables the dialog option to preview the picture 
attachments, see 6.9 for additional details.

The “Time” option allows to display time as Local or GMT.
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 6.3 Basic Use Case
Double click of the mboxview to start the viewer. The picture below shows the screen created by 
the mboxview after few steps performed by a user. Mail Archive, Summary and Message windows 
are initially blank after start-up. Steps to load a mail archive and display the content are described 
next.

1. Click on the “File” to open the drop menu and then select the “Select folder...” option. 
Browse to the folder containing one or more mbox and/or eml mail archive files and select 
it. All valid mail archive files will appear in the Mail Archive Tree window.
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2. Click on one of the archive files to load all mails within the archive.  Progress bar will 
appear and automatically close after the selected archive is fully processed.  Mail header 
information of each email will appear in the Summary window.

Note that parsing of very large archive file may take some time since the mail archives are 
text files and every character has to be examine one by one.  However, subsequent loading 
of mails is done from the index file created by the mboxview during the initial parsing of the
archive file.  The created index file contains the header information, content meta data of 
each mail in the archive file and the position of each mail within the mail file for quick 
access to the mail message/body. Loading from the index file is much faster. The index files 
have the .mboxview suffix.
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3. Left Click on one of the mails in the Summary window to show the Message/Body of that 
email in the Message window. The mail retrieval state is shown on the status bar.    Opening 
a link within an external browser is recommended since running Java or scripts or ActiveX 
controls is disabled in the internal browser to improve security.

 6.4 Message Window Position
Message Window position can be set to Bottom, Right or Left via View→Message Window option. 
After setting new position, mbox viewer needs to be restarted for the change to take effect.

When position is set to Right or Left, the mail address format will change to show mail name only 
or mail address if the name is missing.

By default Message Window position is set to Bottom.
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 6.5 Mail Context Menu
Right Click on a selected email in the Summary Window to open the context menu as shown below.

The “Print” context menu allows to print the selected email or group of emails (conversations) to 
Text or HTML files, send to the user selected printer or to open in the external default application. 

The “Find” option allows to find user defined text and highlight all occurrences in the Message 
windows.

The “Find Advanced” options will start the advanced search dialog and pre-populate From, To and 
Subject fields from the mail.

 6.5.1 File Names

User can configure file name pattern to apply when printing single mail by selecting File -> Print 
Config dialog. Pattern is composed from Date, Time, From, To, Subject and Unique Id fields. Only 
alpha numeric characters are selected from the Subject, other characters will be replaced with the 
underscore. These files will be saved in the FolderHousingMailArchives/PrintCache/XX folder, 
where XX matches corresponding archive file name.

User must enter target file name manually when printing to printer, i.e. when selecting Print to → 
printer mail option or when printing mail to pdf file from the browser. Alternatively, user can open 
file location and cut and paste created corresponding *.htm file name.

Print Config dialog allows users to configure the maximum length of created file. The maximum 
file path length supported by Windows is 260 characters on non Unicode applications. Therefore the
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file name will be limited to (260 – length of FolderHousingMailArchives/PrintCache/XX) path. 
User should set wanted file name length limit and the mbox viewer will adjust the configured length
if needed.

When printing multiple selected mails, the name of the created file will be created based on the 
archive file name with the .txt or .html suffix in the FolderHousingMailArchives/PrintCache/XX, 
where XX matches the archive file name.

 6.6 Mail Archive Context menu
Right click on the active mail archive under the Mail Archive Tree Window to open the context 
menu as shown below.
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The context menu allows to print all email to CSV or Text or HTML files. The name of the created 
file will be created based on the archive file name with the .csv or .txt or .html suffix in the 
directory housing the archive file. NOTE that mails will be printed according to the sort order in the
summary window.

Size of HTML file can be very large and opening in some browsers can be problematic. Microsoft 
Edge and Google Chrome browser seem to perform best as far as handling large HTML files.

HTML to Text conversion was added in 1.0.2.8 to handle mails with HTML text block and no Plain 
text. Conversion is quite slow and print time could increase significantly compared to 1.0.2.7 in 
case a large number of conversions is required. Progress bar was added to indicate progress, 
possibly slow progress.

All mails of the active archive can be sorted by date, from, to subject, size and conversations in the 
Summary Window. This feature is the same as the left click on the selected column in the Summary 
Window.

The “Properties” option shows the archive file location, size and email count

The “Refresh Index File” option will perform fresh parse of the archive file if needed.

 6.6.1 Print to CSV File Dialog

When printing selected mail archive to CSV file, user can select what fields to export and the date 
format.

Option to normalize content encoding is also available. Default encoding is set to UTF-8 and should
not be changed except possibly in special cases.
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 6.7 Mail Attachments
Mail attachments are shown at the bottom of the Message window. Note that the “*’ character may 
appear in the first column for the associated mail to indicate presence of associated attachments. To 
open location of attachments, double click on the mail in the Summary window or select 
“View”→”ViewEML” menu option.  Temporary folder will open containing all attachments for the 
email. Use standard Windows applications to view attachments.

You can also double left click to view attachments. Picture attachments will be viewed in the 
Picture Viewer (if configured in the global Options) and other file types will be viewed by the 
associated default Windows applications.

13



 6.7.1 Attachment context menu

Right click on the selected attachment to open the context menu. The context menu allows to open 
or print the attachment by the associated default application. You can also open the folder housing 
the attachment. The selected attachment will be highlighted in the folder.

 6.8 Inline Image Cache
The mboxview will create the cache of inline images to support images embedded directly into the 
mail body/message. The cache is created during the initial parsing of the mail archive file. Separate 
cache folder is created per each archive file (assuming at least one inline image was found) in the 
FolderHousingMailArchives/ImageCache folder.  If the inline image cache is missing for any 
reason, try to refresh the index file by selecting “Refresh Index File” context option on the 
respective file archive.

 6.9 Picture Viewer
Double left Click on any attachment to start Picture Viewer dialog, example below.
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The Picture Viewer supports files with the png, jpg, jpeg, jpe, gif, bmp, ico, tif, tiff, jfif, emf, wmf, 
dib suffixes.

The NEXT and PREV controls enable user to browse all picture/image attachments associated with 
the selected email. You can select specific attachment to be displayed. You can later browse through
all picture attachments.

The ROTATE control allow to rotate clockwise the current/visible picture.

The ZOOM control allows to zoom in/out picture. Click on ZOOM to enable/disable zooming. 
Slide to right to enlarge an image, slide to left to shrink.  Enlarged image can be dragged using the 
left and scroll buttons of the mouse. Click ZOOM to disable zooming and reset the image to 
original size.

The PRINT control allow to print via default application.

The Picture Viewer is enabled by default but it can be disabled via FILE→Options dialog. Setting 
persists in the Registry across multiple runs.

All attachments are also accessible by double clicking on the selected mail in the Summary window
or by selecting “View”→”ViewEML” menu option.

 6.10 Mail Navigation
Click on a specific mail in the Summary window and use UP, DOWN keys to move to the next or 
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previous mail respectively.

Use HOME key to jump to the first mail. Use END key to jump to the last mail.

 6.11 Mail Sorting
The Summary window is divided into 6 columns: attachment indicator, date, from, to, subject and 
mail size. Each column can be sorted by clicking on the column title. Subsequent click on the same 
column title will reverse the sorting rule. By clicking on the attachment indicator title, emails are 
sorted by conversations and mark by different colour as shown below.

Mail can also be sorted via the mail archive context menu or by selecting  “File”->“Sort By” menu 
option.

 6.12 Dynamic Column Resize
Columns in the Summary windows are automatically resized when the window is resized.

However, if columns are resized manually, some of the columns may no longer be present in visible
area/window. 

You may need to use the scroll bar to see missing columns, otherwise maximize and then restore the
window to see all columns within the Summary window again.

 6.13 Mail Searching
Mbox viewer supports two search options, i.e. basic Find and advanced Find.
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The basic Find option allows users to specify single keyword for searching across header fields, 
mail text and attachments. 

The advanced Find option allows user to specify keyword per each header field, mail text and 
attachments.

 6.13.1 Basic Find

The basic Find option allows users to specify single keyword/string for searching across header 
fields, mail text and attachments

Users can configure the search scope by selecting all or subset of the from, to, subject, message and 
text attachments options.

Click the “Edit” drop menu and select “Find” option to configure and start the search. Alternatively 
the CTRL+F will also present the search dialog.

The search dialog box allows user to specify the search string, whether to match the whole word, 
whether the search is case sensitive, configure the search scope, the start and end dates to consider 
for filtering, the Next/Previous search direction and whether to highlight all occurrences of the 
matched text.

Note that the Next search start with the oldest email while the Previous search starts with the latest.

The search logic simple, i.e. mail is considered a match if the search string is found in any of the 
checked fields I that mail.

To repeat the search in order to find the next matching mail,  click the “Edit” drop menu and select 
“Find again” option, or select F3 key. 

If  “Find again” or F3 key is selected without prior “Find” or CTRL+F, the search dialog box will 
be presented to a user.
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 6.13.1.1 Find All Occurrences Option

User can check “Find all occurrences” to find all matching mails. Highlighting of all keyword 
occurrences is not supported in this case. Matched mails will be displayed under the Find Mails List
and the corresponding button in the dialog bar will be highlighted. User can left click on All Mails 
button to switch mail list back to All Mails. 

The basic Find can also be run while in the Find Mails list and while in User Selected Mails list 
when the list is enabled.

 6.13.2 Advanced Find

The advanced Find option allows user to specify keyword per each header field, mail text and 
attachments.

Users can configure the search scope by selecting all or subset of the from, to, subject, message and 
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text attachments options.

Click the “Edit” drop menu and select “Find Advanced” option to configure and start the search.

The Find Advanced is also available as menu option for the selected mail. Right click on the mail  
and select Find Advanced option. Mbox viewer will pre-populate From, To and Subject fields in this
case.

Only checked fields are use by matching logic, search strings are ignored if present unless field is 
checked.

The search logic is hard-coded for most common cases and described in the search dialog.

 6.13.3 Search Reliability

Searching may not work as expected in all cases due to different character sets on input and in the 
mails.

Base64 or “quoted-printable” text content blocks and text attachments are first decoded before the 
search to eliminate false negative results.

Searching of the header fields is performed on the received raw data.

Raw mail data may contain plain text and/or html text blocks. Both encode the same/similar 
content. If the mail contains plain text blocks, only plain text will be searched. If the mail doesn’t 
contain any plain text blocks, the html text blocks will be searched.

False positive results may happen when searching text/html content blocks since the html tags are 
not ignored when searching. The search string may match one of the html tags and result in false 
positive match.

If possible, use ASCII characters only to compose the search string.
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 6.13.4 Special Search Key

The single character ‘*’, i.e. the star character can be specified as the search string to enable 
traversing the subset of mails between the start and end dates.

 6.13.5 Search Progress Bar

Search progress bar displays the progress along the configured search string and enables user to 
cancel the search is so desired. The progress bar is not created unless a given search duration lasts 
longer than the delay time controlled by -PROGRESS_BAR_DELAY command line option or 
specified via GUI. Default value is 1 second.

 6.13.6 Search Performance

Searching of header fields performs best since all fields reside in the memory.

Searching of messages and text attachments may take some time for very large files, say larger than 
10-20 Gbytes. Search requires to read the content blocks from the email file and decode the content 
when required. Worse case scenario is when the specified search string is not present in the mail 
archive. When activated, the search progress bar shows the configured search string and enables 
user to cancel the search is so desired.

Note that when searching of message and text attachments is configured, all mails will be sorted by 
date first, except when sorted by conversations,  to maximize search performance.

 6.14 Refreshing Archive Tree Window
If an additional mbox or eml file is placed in the already selected folder, the Archive Tree window 
needs to be refreshed to see the new additions. This can be done by selecting “Refresh” option 
under the “File” drop menu or by clicking on the button showed below.
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 6.15 Language (Character Sets) Support

 6.15.1 Message Window

Different languages (character sets) are properly supported in the Message Window. This is thanks 
to the Microsoft Web Browser emulation/control class integrated into the mboxview. The mboxview
generates the htm file from the mail’s body and Web Browser displays the generated file in the 
Message window.

Display may not be correct if the character set for the mail’s body is not defined in the mail. To 
resolve the incorrect display, you can try to apply different encoding by right clicking within the 
window, selecting “encoding” and “more” options to apply different language.

 6.15.1.1 Header of Message Window

The text of the mail header fields is displayed correctly as long as the corresponding field encoding 
type is present in the email. 
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Two global options can be used to address incorrect field presentation in the Message Header in 
case the field encoding is not present in the email.  Missing field encoding type may or may not be a
problem. It should not be a problem if the default/local character set installed on your computer 
matches the original encoding of the header fields. It might be an issue if you are receiving emails 
from different countries.

As shown below,  you can see all encoding/character sets applied to the header fields by enabling 
“Show Charsets” option.  To enable, select “Options” from the “File” drop menu and enable “Show 
Charsets”.

If the field text presentation is not correct, you can try to configure character set (or so called code 
page according to Microsoft terminology) for the selected header fields and see if that helps. Per 
field code pages can be configured via Options dialog box.  Note that the user provided encoding 
doesn't override encoding in the email, if present, which is denoted by the code page greater than 
zero. Code Page set to zero indicates missing or unknown character set.

If you change the code page value(s) in the Options Dialog box, you need to refresh the selected 
email by going up and down (or down and up).

All Windows supported code pages are listed in chapter 7 or can be viewed in the external Browser 
by selecting “View”→”View Code Page Ids”.

The character set information appears after the field title and is formatted as “(character set 
name/code page)”.  The ‘*” star character is appended after the code page if the user specified code 
is applied). Example “(UTF-8/65001*)”.  

The character set information after the “Date:’ title shows the local/default character set installed on 
your computer.

22



 6.15.2 Summary Window

Mail header fields are displayed correctly as long as the corresponding field encoding type is 
present in the email. 

 6.16 Mail List Auditing
Mail list auditing capability enables users to compose mail list from all mails by merging results of 
multiple searches and/or by merging one or more user selected mails.

To support list auditing, the Mbox Viewer maintains 3 internal mail lists:

• All Mails list is populated from the selected archive file under the Mail Tree.
• Find Mails list is populated by the search results. User can run Find Advanced dialog or set 

the Find All Occurrences option in the Find dialog.
• User Selected Mails list is composed by a user from the mails in the All Mails and Find 

Mails lists.

Each internal mail list has associated button in the dialog bar located next to the tool bar. When a 
particular mail list is shown in the Mail Summary Window, associated button is highlighted.

Access to the User Selected Mails list is disabled upon startup and the associated Button gray out. It
can be enabled by the user to perform simple list auditing if desired by selecting View->User 
Selected Mail List to enable/disable.

When User Selected Mails list is enabled, additional mail menu options will also be enabled such as
Copy Selected Mails to User Selected Mails.

Content of the User Selected Mails list is controlled by the user. User can merge search results with 
the content of the User Selected List.

User can run the search multiples time and merge results multiple times with the User Selected List.
Search results can be pruned before merging.

In addition, user has an option to select/highlight one or more mails in the Summary Mail Window 
and copy to the User Selected Mails list. 

Standard Windows method is used to select and highlight multiple mails, i.e. Shift+Left Click and 
CTRL+Left Click.

Merging/copying process will not create duplicate mails in the User Selected List.

User can select and highlight one or more mails in the Summary Mail Window and remove from the
active list. Mails can't be removed from the All Mails list.

All Mails list content persists until new mail archive is selected.

Find Mails list content persists until new search or when All Mails list is invalidated.

User Selected Mails list content persists until cleared by the user or when All Mails list is 
invalidated.

23



 6.16.1 Mail List Archiving

Find Mails list and User Selected Mails list content can be saved to new mbox archive files.

Archive file will be created in the same folder as the All Mails main archive.

Archive file created from the Find Mails list will be created by appending _FIND suffix to the base 
name of the main archive file name.

The _USER suffix will be appended when creating archive file from the User Selected Mails list.

For example, if the main mbox archive file from gmail is called "All mail Including Spam and 
Trash.11.09.2018.mbox", then created archive file will be named "All mail Including Spam and 
Trash.11.09.2018_USER.mbox."

When creating archive file for User Selected Mails list, the mbox viewer will also create file with 
the list of all mails for that archive, for example "All mail Including Spam and 
Trash.11.09.2018_USER.mbox.mboxlist."

The mail list file allows user to reload the last archived mail list into the User Select Mails. Reload 
can be requested at any time including after restart of the mbox viewer.

After mbox viewer is restarted or when User Selected Mails List is empty, User Selected Mails list 
can be restored when All Mails list is active.

When User Selected Mails list is active, it can be reloaded when List is not empty.

 7 Windows Code Page Identifiers
The table below shows the supported character sets/code pages by Windows platform. The list is 
based on the following link.

https://msdn.microsoft.com/en-us/library/windows/desktop/dd317756(v=vs.85).aspx

CodePage Name Display Name

37 IBM037 IBM EBCDIC (US-Canada)

437 IBM437 OEM United States

500 IBM500 IBM EBCDIC (International)

708 ASMO-708 Arabic (ASMO 708)

720 DOS-720 Arabic (DOS)

737 ibm737 Greek (DOS)

775 ibm775 Baltic (DOS)

850 ibm850 Western European (DOS)

852 ibm852 Central European (DOS)

855 IBM855 OEM Cyrillic

857 ibm857 Turkish (DOS)

858 IBM00858 OEM Multilingual Latin I

860 IBM860 Portuguese (DOS)

24

https://msdn.microsoft.com/en-us/library/windows/desktop/dd317756(v=vs.85).aspx


CodePage Name Display Name

861 ibm861 Icelandic (DOS)

862 DOS-862 Hebrew (DOS)

863 IBM863 French Canadian (DOS)

864 IBM864 Arabic (864)

865 IBM865 Nordic (DOS)

866 cp866 Cyrillic (DOS)

869 ibm869 Greek , Modern (DOS)

870 IBM870 IBM EBCDIC (Multilingual Latin-2)

874 windows-874 Thai (Windows)

875 cp875 IBM EBCDIC (Greek Modern)

932 shift_jis Japanese (Shift-JIS)

936 gb2312 Chinese Simplified (GB2312)

949 ks_c_5601-1987 Korean

950 big5 Chinese Traditional (Big5)

1026 IBM1026 IBM EBCDIC (Turkish Latin-5)

1047 IBM01047 IBM Latin-1

1140 IBM01140 IBM EBCDIC (US-Canada-Euro)

1141 IBM01141 IBM EBCDIC (Germany-Euro)

1142 IBM01142 IBM EBCDIC (Denmark-Norway-Euro)

1143 IBM01143 IBM EBCDIC (Finland-Sweden-Euro)

1144 IBM01144 IBM EBCDIC (Italy-Euro)

1145 IBM01145 IBM EBCDIC (Spain-Euro)

1146 IBM01146 IBM EBCDIC (UK-Euro)

1147 IBM01147 IBM EBCDIC (France-Euro)

1148 IBM01148 IBM EBCDIC (International-Euro)

1149 IBM01149 IBM EBCDIC (Icelandic-Euro)

1200 utf-16 Unicode

1201 unicodeFFFE Unicode (Big-Endian)

1250 windows-1250 Central European (Windows)

1251 windows-1251 Cyrillic (Windows)

1252 Windows-1252 Western European (Windows)

1253 windows-1253 Greek (Windows)

1254 windows-1254 Turkish (Windows)

1255 windows-1255 Hebrew (Windows)

1256 windows-1256 Arabic (Windows)

1257 windows-1257 Baltic (Windows)

1258 windows-1258 Vietnamese (Windows)

1361 Johab Korean (Johab)

10000 macintosh Western European (Mac)
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10001 x-mac-japanese Japanese (Mac)

10002 x-mac-chinesetrad Chinese Traditional (Mac)

10003 x-mac-korean Korean (Mac)

10004 x-mac-arabic Arabic (Mac)

10005 x-mac-hebrew Hebrew (Mac)

10006 x-mac-greek Greek (Mac)

10007 x-mac-cyrillic Cyrillic (Mac)

10008 x-mac-chinesesimp Chinese Simplified (Mac)

10010 x-mac-romanian Romanian (Mac)

10017 x-mac-ukrainian Ukrainian (Mac)

10021 x-mac-thai Thai (Mac)

10029 x-mac-ce Central European (Mac)

10079 x-mac-icelandic Icelandic (Mac)

10081 x-mac-turkish Turkish (Mac)

10082 x-mac-croatian Croatian (Mac)

12000 utf-32 Unicode (UTF-32)

12001 utf-32BE Unicode (UTF-32 Big-Endian)

20000 x-Chinese-CNS Chinese Traditional (CNS)

20001 x-cp20001 TCA Taiwan

20002 x-Chinese-Eten Chinese Traditional (Eten)

20003 x-cp20003 IBM5550 Taiwan

20004 x-cp20004 TeleText Taiwan

20005 x-cp20005 Wang Taiwan

20105 x-IA5 Western European (IA5)

20106 x-IA5-German German (IA5)

20107 x-IA5-Swedish Swedish (IA5)

20108 x-IA5-Norwegian Norwegian (IA5)

20127 us-ascii US-ASCII

20261 x-cp20261 T.61

20269 x-cp20269 ISO-6937

20273 IBM273 IBM EBCDIC (Germany)

20277 IBM277 IBM EBCDIC (Denmark-Norway)

20278 IBM278 IBM EBCDIC (Finland-Sweden)

20280 IBM280 IBM EBCDIC (Italy)

20284 IBM284 IBM EBCDIC (Spain)

20285 IBM285 IBM EBCDIC (UK)

20290 IBM290 IBM EBCDIC (Japanese katakana)

20297 IBM297 IBM EBCDIC (France)

20420 IBM420 IBM EBCDIC (Arabic)
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20423 IBM423 IBM EBCDIC (Greek)

20424 IBM424 IBM EBCDIC (Hebrew)

20833 x-EBCDIC-KoreanExtended IBM EBCDIC (Korean Extended)

20838 IBM-Thai IBM EBCDIC (Thai)

20866 koi8-r Cyrillic (KOI8-R)

20871 IBM871 IBM EBCDIC (Icelandic)

20880 IBM880 IBM EBCDIC (Cyrillic Russian)

20905 IBM905 IBM EBCDIC (Turkish)

20924 IBM00924 IBM Latin-1

20932 EUC-JP Japanese (JIS 0208-1990 and 0212-1990)

20936 x-cp20936 Chinese Simplified (GB2312-80)

20949 x-cp20949 Korean Wansung

21025 cp1025 IBM EBCDIC (Cyrillic Serbian-Bulgarian)

21866 koi8-u Cyrillic (KOI8-U)

28591 iso-8859-1 Western European (ISO)

28592 iso-8859-2 Central European (ISO)

28593 iso-8859-3 Latin 3 (ISO)

28594 iso-8859-4 Baltic (ISO)

28595 iso-8859-5 Cyrillic (ISO)

28596 iso-8859-6 Arabic (ISO)

28597 iso-8859-7 Greek (ISO)

28598 iso-8859-8 Hebrew (ISO-Visual)

28599 iso-8859-9 Turkish (ISO)

28603 iso-8859-13 Estonian (ISO)

28605 iso-8859-15 Latin 9 (ISO)

29001 x-Europa Europa

38598 iso-8859-8-i Hebrew (ISO-Logical)

50220 iso-2022-jp Japanese (JIS)

50221 csISO2022JP Japanese (JIS-Allow 1 byte Kana)

50222 iso-2022-jp Japanese (JIS-Allow 1 byte Kana - SO/SI)

50225 iso-2022-kr Korean (ISO)

50227 x-cp50227 Chinese Simplified (ISO-2022)

51932 euc-jp Japanese (EUC)

51936 EUC-CN Chinese Simplified (EUC)

51949 euc-kr Korean (EUC)

52936 hz-gb-2312 Chinese Simplified (HZ)

54936 GB18030 Chinese Simplified (GB18030)

57002 x-iscii-de ISCII Devanagari

57003 x-iscii-be ISCII Bengali
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57004 x-iscii-ta ISCII Tamil

57005 x-iscii-te ISCII Telugu

57006 x-iscii-as ISCII Assamese

57007 x-iscii-or ISCII Oriya

57008 x-iscii-ka ISCII Kannada

57009 x-iscii-ma ISCII Malayalam

57010 x-iscii-gu ISCII Gujarati

57011 x-iscii-pa ISCII Punjabi

65000 utf-7 Unicode (UTF-7)

65001 utf-8 Unicode (UTF-8)

 7.1 Handling Unknown Code Page Names
In a few cases, mboxview will map unknown code names to the equivalent code names supported 
by Windows.

Unknown Code Name Mapped To Code Name

gbk GB18030

cp1252 Windows-1252

ascii us-ascii

cp819 iso-8859-1

latin1 iso-8859-1

latin2 iso-8859-2

big-5 big5

SJIS shift_jis
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